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Ol BiiA|Zl= 22 & USB S2iAl E2t0| 20| 7|85 staidl A=

H

ol
AR

S Of LtetgLch

USB device read/write error.

USB S2iA| E2t0|EE 97L& I 277 S Ch

AN

USB device will be formatted.

Ol HIA|R|= USB &2|7t ZSHx| 7| HOf LIEF LT

Waveform full.

_
B A2 MM T IOl Hoh WM 27 2o AS LT




AMEBEZL SR SsUN? 2RE AA2EZE 2HE U 012 22 A7t LUSHH X F0| 0] 40| et THESHI| o
e FES UMY A2, HI0|E{E USB 22iA| E20[ (60T 0| A)2 et = T 0|8 27|SH(19T| 0| X)E LS T2
ZAE MBS + ASHC D= A7t 2| 2| W Yamaha T30 2|5t Al 2.

E1z| j'd 0] SH2A| 2t35}2]| S L ).

m E{X| I{E0j| A Ef 2|5k [0l Of2f St T4 etk SHIEA YA ASHI?
B2 {E S WYSHYAI2.
[UTILITY] + [PART SELECT MUTE/SOLO] - [ENTER]
[UTILITY] - [Settings] - [System] - [Calibrate Touch Panel]

M2E7F 28 E[A] E5UT
® RS 220[C{7h (0 E 2{47tobdl) A W2 YHE|Of YSLITN?

=
= MODX+7t b2 A 0|25 S lﬂ QE (0 T, AL|FH, S EZ)0 SBIEA HE0f ASLIIN?
MODX+0fl& AT|H7t LI |0 AA| 202 A% LHEI S ?loiM e 2 F 202 A| A" £ AL =2 METL
KB CH(18T 0] A]).

kg

o
=
AICIAROI R HRA0] 2 U MCIALO| 0| HZE 9% Z2|0| HAUO| HH YL
m AICIARO|HO| F S U HE R B O SY HYS

HEZ2{7} [FOOT CONTROLLER] 240f o
o

o A
= =
n 22 HEZ Mt0IE7t HY 22 2= ASHIN?
2 AEE M2|0|E7} HRACE2 MAE AL 7

[UTILITY] > [Settings] = [MIDI 1/0] = “Local Control”

[PERFORMANCE (HOME)] > OE “Mute”
[PART SELECT MUTE/SOLO] - “Mute” > ItE ME4

m 2 I}EO| et HEZ0| A YS LN

-

[PERFORMANCE (HOME)] -> I}E “Kbd Ctrl”

m 2} IHE 9| “Arp Play Only” I}2t0|E{ 7} 2% Q& LI7}?
O mt2tO|E{ 7t A UES W= oY THET OF2 M| 2| 2 A4S S A 2 &2|7F gL Lt
[PERFORMANCE (HOME)] > ItE MEH > [EDIT] > [Part Settings] > [General] > ‘Arp Play Only”
[PERFORMANCE (HOME)] - I} E A4 > [EDIT] - [Arpeggio] = [Common] > ‘Arp Play Only”

m 2R HEZ2 0|8 A MIDI SZ0|Lt MIDI B3 HEO0| HE 2| L& L7?
JIIE-| AEiZ-Io| 7\47('|o|'|_|7]|-
LEE AIE 30 B3R 2 2O4E HEN EMA2. 22 2t

[PERFORMANCE (HOME)] = [EDIT] > [Effect]

nx
o

CE2 RE Y0l 2 + UG

[PERFORMANCE (HOME)] > I}E A4 > [EDIT] > [Effect]

ot OE (AWM2) & AU CE2OES FR

[PERFORMANCE (HOME)] > IIE AE4 > [EDIT] > 24/7| ME} > [Filter]

Aot MHE(FM-X)9| 2%
[PERFORMANCE (HOME)] > I}E AEH > [EDIT] > 2IH2|0|E{ AME4 > [Pitch/Filter]
m “Vocoder'7} THE O] OIME O|HME E}QIo2 MEHT| Q& L|7}?

J%CHR1 AD INPUT [LIMONOJIR] {2 221 €l TH20/E{S 228t 2O 2 S5 5 MODX+0| A2 Opo| 20f S4
SHBIA 212 HIRBHUAIR. 9 I AD INPUT [GAIN] =57t 214 91312 S E|0f 47| e a] EolstiAle

rulo
e
i

[EDIT] > IOIE MEH 5> @ A/7|/2TH2{|0|Ef [Common] - [Effect] > [Routing]



m SZYO|Lt B HYO| T 2| 57
[UTILITY] = [Settings] > [Sound] > € |42 0| E{ “Volume”
[EDIT] - [General] - “Volume”
[EDIT] > IOIE MEH 5> @ A/7|/2T42{| 0| [Common] > [Part Settings] > [General] > “Volume”

[EDIT] > LIE MEf > 24/7|/21H 2 0|E [Common] > [Part Settings] > [General] > “Dry Level”

- Yot IE(AWMD) Y £ ThE0| 32

=

[EDIT] > IIE ME} > 2 A/7| Med > [Amplitude] > [Level/Pan] > “Level”

o Ut IHE(FM-X)S] Z2

[EDIT] > ItE MEH > QT O|E| MEH > [Level] > “Level”
m oA ALRZ, Zote, M7| ot I M7| 2T Al 22 Tp2t0|E HE 0| H-E gL 7t
o UBHIMEAWM2) Y =3 TIES| F 2

[EDIT] > IOIE MEH 5> 2 4/7|/21T42{ 0| & [Common] > [Part Settings] > [General]

[EDIT] > IIE MEH > 2A/7| MEH > [Osc/Tune]

o AUt ME(F

<
>

|0

| 3

40

)
[EDIT] > IOIE MEH 5> 2 A/7|/2 12| 0| [Common] > [Part Settings] > [General]

m I}E 0| 2t R4/ T2 0|E{OICE S 4K AQIX|Tt HH US LI

[EDIT] > OIE MEH > 2} Q A/QTH2|0|E{Q] SAH A Q||

m Q8 MHE(FM-X)2| F2 712/0f 22 0| "0"2= HH |0 AFLIT?

[EDIT] > OtE MEf > @T42{|0|E{ MEH > [Level] > “Level”

w 2} HEO| £ m2t0|E{ 7t HA ASHI?

[EDIT] > IOIE MEH 5> @ 4A/7|/2TH2{| 0| & [Common] > [Part Settings] > [General] > “Part Output”

A/D INPUT 2of| A Ot S HHE[A] &L

m OFO| 3 ARI2|7F HA ASUIH?

m 00|32 RS &5t Al2. CHO[LHY] DOrO[2E AHE 3l OF BHLICh.

m 0}0|3 = 202 ZH|eF 2 27| AtO[of HO| S0 Ath2 A ZEASLIN?

m A/D INPUT [GAIN] =B 7} 2|4 Q2|2 Z0tZt Aref & L 7t?

m A/D INPUT [ON/OFF] B{E0| HAH JA&U7I}?

m A/D INPUT [L/IMONOQY/[R]2| HZ AEf 7} “Mono/Stereo” It2t 0| & 2F U 2|5t=2Z| &l
[EDIT] = [Audio In] = [Mixing] > A/D In “Input Mode”

P AL,

o]

m ‘Mic/Line” T2t 0|E{ 7} 4 A5t Zfo =2 YL YA 6 FE HUSIYAI2.
HZE Z2(0f: 0r0] )2 =3 E1|”£0| &S W= 0] Ifet0lEE "Mic’2 Y LT HEE FR[(Of: LT/ ALO[A 2t

=2 [S ey

=
CD 22{0[0f)e] 28 +&0| =5 We 0| 2¥& "Line"’22 2 U T

[UTILITY] - [Settings] > [Audio I/0] > “A/D Input’

" AD 2RO 83 HHO| L2 UL

[EDIT] = [Audio In] = [Mixing] = A/D In “Volume”
® O[T E 40| AT M}?

[EDIT] = [Audio In] = [Routing]

n AD Y0l 20| HHs A0 YU

[UTILITY] - [Settings] - [Audio I/0] > &3

m 230 O|HETJH MEHL|0] A=2| &QISHYAIL.
HIAMEZ 5 IEO| OIAE O|HME deu%_} Z <2 m2tolE Mo w2t A/D INPUT [L/MONOJ/[R] HOlM & E 202
Ao YOI o S = YH5HA ¥2 & UAFUICH

[EDIT] > DtE ME} > 2 A/7|/2 14| 0| Ef [Common] > [Effect] - [Routing]



40| M|/ 93 A& LIt
= [ARP ON/OFF] BIE0| 23 22 B{E I} 77| E2 0] HES F&LUCH
= & 31210] BAIZ of (W] (H3)
m 20|9 22 O|HE 30| AT O]

0

HE MG SIS CHA HEUAS MEkFL|Ch
\

m Y25HE 22| AL T OHS Met0|E £ 2QIStYA|2. O] Ip2t0E & “always"2 QYT AlH
L2fots A2Vt Sy S22 2 "always” 0[2|9| CHE HEHZ ZESIHAIR.

[UTILITY] >[Tempo Settings] > ‘El’ “Mode”

AM2E7) 5L

= O[HE MO HHELII?
S 4730l OMES AIBHIH A R0| Ly

[EDIT] > ItE MEH > @ 4/7|/2142{ 0| Ef [Common] > [Effect]

 LE| 40| HHFL I

LE B Y0 42 EO0 oo WA 4 UsUT
o YBHIIE(AWM2) 2 £ TIEQ| 32

[EDIT] > ItE ME} > 2 A/7| MEH > [Filter]
. YgHTHE(FM-X)2| 32

[EDIT] > TO}E MEH 5> 2 A/7|/2H2{ 0] E{ [Common] > [Pitch/Filter]

m O30 S I2t0H 2 S otLiete =2 2 =0 A0 S2/H0| St ASU?
[UTILITY] - [Settings] > [Sound] > £ A|42{|0|E{ “Volume”
[UTILITY] = [Settings] = [Audio I/O] > “Output”
[EDIT] > [General] > “Volume”
[EDIT] > IOIE MEH 5> 2 A/7|/2T42{| 0| [Common] > [Part Settings] > [General] > “Volume”

. UBHIIE(AWM2) X £ TEQ| B9

=
[EDIT] > ItE ME} > 2 A/7| MEd > [Amplitude] - [Level/Pan] > “Level”

=

- L8t IEFMX)Q| Z 2

[EDIT] > MtE ME > 21{2{|0|E| &4 > [Level] > “Level”

>
Rl
r

2L} 2 ehE L o

w g A A S/IME/OIEH X2 Y S Sl 22 & WA S0] MODX+2| 2t SAZESH(AWM2 12874 & FM-X 12871)E
Eanix=l

ot o sfLie| S A 2] EL L.

[
m O|2{3t & 20| LHTICHH S RE0|M 2/2 2| THet0|E{7t "mono”’2 Y &[0 U= A YU CH
E AFE st® O] I2t0|H E “poly"= 2 St AI2.

[EDIT] > IOIE MEH 5> 2 A/7|/2TH2{| 0| [Common] > [Part Settings] > [General] > “Mono/Poly”

oz & 2H40] ZX £ ASLT.
w2 OHE |u+¢ S T2t0jE{7} 0" 0| 2lo] Ch2 o2 HAE O AL

[UTILITY] - [Settings] = [Sound] > € A|42{|0|E “Tune”

m 2t TIHEO[ & O|F Ot2td|E{ 7t “0” 0|2l 2| CHE gt 2 ML ASUIN?
e ABFIME(AWM2) & EZH IEQ F2
[EDIT] > O}E MEH > 2 A/7|/2TH2|0|E{ [Common] > [Part Settings] > [Pitch] > “Note Shift’
9

[EDIT] > ItE MEH 2/7|/2 12| 0| | [Common] - [Part Settings] - [Pitch] > “Detune”

o QB I} E (FM-X)

|0

| 8

40

[EDIT] > ItE MEH > @ 4A/7|/2142{| 0| Ef [Common] - [Pitch/Filter] - [Pitch] - “Note Shift”
[EDIT] > IIE ME{ > 2 4A/7|/2142{| 0|E{ [Common] = [Pitch/Filter] > [Pitch] > “Detune”



m OIEOM Z2RE O2[7} d4El= 22 00|22 T T2t0|E0|M H Aot T'd A|ARO0| HMEHL|Of JELIT?
o UBH I E(AWM2)| 2
[EDIT] > LIE MEf > 24/7|/21H2{|0|E| [Common] > [Part Settings] > [Pitch] > “Micro Tuning Name”
o UgHTEE(FMX)Q Z2
[EDIT] > IOIE MEH 5> @ 4/7|/2TH2{| 0| & [Common] = [Pitch/Filter] = [Pitch] - “Micro Tuning Name”
m OEO|M Z2RE T2 7t ddsl= 2R LFO 0|2 M2 2017t U2 =2 dH = AGUIN?
- Yt IEAWM2)9] 32
[EDIT] > ItE MEH > @ A MEH 5 [Element LFO] > “Pitch Mod”
* YU THE(FM-X)2| 22

[EDIT] > ItE MEH > Q 4/7|/2142{| 0| E{ [Common] - [Mod/Control] = [2nd LFO] = “Pitch Modulation”

m MEOM ZRE L2V 9=l = 392 AM J L OM &Y 2Y0] A&7
o

- YT THE(AWM2) U S THEC| 32
[EDIT] > ItE MEH > @ A/7| MEH 5 [Osc/Tune] - “Coarse”
[EDIT] > THE ME4 > 24/7| MEf > [Osc/Tune] > “Fine”

- UB TIEFMX)O FS
[EDIT] > ItE MEHd > 2142{|0|Ef ME4 > [Form/Freq] > “Coarse”
[EDIT] > OtE MEH > 2T42{| 0|E{ MEH > [Form/Freq] > “Fine”

w DEOM ZRE T2Vt dele AAE E0l= d2 AES2 0| “Pitch”2 Y= 0] ASU7IN?

L—=

[EDIT] > IOtE MEH > [Mod/Control] > [Control Assign] > “Destination”

O|HET} 2{E&|2| ¢&LICH

O[HE AR} HA AgUt?

[UTILITY] - [Effect Switch]

mHIHE T = 2|HE 50| 0" 0|2 CHE e = H4E o JA&H I
[EDIT] > O}E ME} > 2 A/7|/2 14| 0| Ef [Common] > [Effect] - [Routing] > “Var Send”
[EDIT] > I{E MEH > 2 A/7|/2 12| 0|E{ [Common] > [Effect] - [Routing] > “Rev Send”

m A 2| = 2|HE 2[]0] “0” 0|29 HE e 2 Y &|of ASHN?

=

[EDIT] - [Effect] > [Routing] > “Var Return”
[EDIT] - [Effect] > [Routing] > “Rev Return”

m 24/7|9| AME O|HE 2 I2t0|H F 5t £= 25 O|HE HYOM thru"2 Y= ASHIH?

[EDIT] > OIE MEf > 24/7|/21H2{|0|§| [Common] -> [Effect] > [Routing] > “Element 1-8”

m A|AEI OHEQ| AR O|HME E}Q 2 5tL} £= 25 “No Effect’2 M A& AS L 7}?
m AME O|HEQS| ZR O|HE EIY F 5t £ 2F "Thru'2 = ASUIN?
m QIME A% T2t0|E It SHI2H HHE 0 A=A AFLICH

[EDIT] > ItE MEH > 9 4/7|/2142{ 0| Ef [Common] - [Effect] = [Ins Al/[Ins B]

" UNE O|HES} HBE ILE £2 ZBYSU
IS 9-169] S QIME O|MES 2/c) 474 THETIR HBF 4 AZ LT

[EDIT] > ItE ME} > 2 A/7|/2 12| 0|E{ [Common] > [Effect] - [Ins Assign]

oI-

O2H|Z2| 25 Al2te &= glaL .
u [ARP ON/OFF] H{E0| 2{# 9l

m OF2I|Z| @ A9|%|7} 77l THEO| £ A ABHLICH
2|0 870 THEZHA) Ol2 T 2|28 SAlo) AHAE 4 ALiT

m 3ot Y MY| ot 22 Ol2H A2 23 m2t0|E 7t A E5] 2F &0 ASLIN?

Al HA A=Al &gt ct.

= =

[EDIT] > LIE MEd > 24/7|/21H2{|0|E| [Common] > [Arpeggio] = [Common]



® OI2T 2|2 34| Tat0|E{7} “off 2 4 HE o AL
[EDIT] > ILE MEH > [Arpeggio] > [Individual] > “Name”

w Ol 2T A2 AQ(Z| I}2t0|E{ S 2HAZLIC}.

o
324 mEo| o met0|E{ 7t “off' 2 M A E Z<S [ARP ON/OFF] H{EO| HA QO{E A EHAZ E5 Of2H 2|2 24440
E2| AR F&LCH

[PERFORMANCE (HOME)] > I} E A4 > ‘Arp On”

m [Arp Bypass] H{£0| ‘on"2 2 A &|0] Y&LI7H?
[UTILITY] -> [Effect Switch]

OI2I|Z| 25 HA|E + AUS L CH
n 7|0H £8 HE OF2TX| 2 X40| H2|5HA Y= A2 OI2WX|Q SE N2t0|E S “off 2 HY3HIAI2.

[EDIT] > IOIE MEd 5> 2 A/7|/2T42{ 0| Ef [Common] > [Arpeggio] > [Common] > “Hold”

[>] (2 HES =2 % $0| A2f=|A] g&L .
n MENE] S0f X2 ClojE{ 7t EBHE|of YBLN?

| ] 0|_>
ajo

| s25%| gLt
=0

0
=30 228 ojR 227t 25| ASHI?
ODX+ H|22|& 2|t 128712 $5 =8 & UASUCH HZE27t 7t= A H 0|49 =82 =7t UL

ne

<

213 E{ 9} MODX+ 7} G| O|E{ EA10] H|CH2 &|R| & L|C}.

n HEE LE MHO| HHFR| SIS,

m MIDI IN/OUT 20| E{ 7t 25t L0 2 MHE|0f Y| 61 E SHOI5HA A2
[UTILITY] = [Settings] > [MIDI /O] > MIDI “MIDI IN/OUT”

MIDI 23 H[0|E] S4l/410] A2 2tF 52| &Lt

w3 A THRtO[E I A2 HHEOf USUIN
W3 £4 Rt0jE{S A2 HABUCE

[UTILITY] > [Settings] - [Advanced] - MIDI “Receive Bulk”

m 83 YT J|58 ARSIl WL E T 9% MIDI 2|0 S52E/= MIDI ¥3 Glo|E{ S 4415 22 MIDI ¥2| M5 S Mg
Aot 2 o= dEslof &Lt
[UTILITY] - [Settings] > [Advanced] - MIDI “Device Number”
HUZ HEE 2] Y= 22 MODX+0| HAZE MIDI 77| #2| HE 7t 22| Ho TetoE et 2|58 dE =0 UL
[UTILITY] - [Settings] - [Advanced] - MIDI “Device Number”

USB Sz Al E2t0| 20 HO[ & A& + USLIC.

=2
m USB S2A| E2t0[ 20 27| H2]| 7|50| AAEELD JASH 77 (HIOHE A &5t 27| H2| S 3iA|5H0F FL )

o

m USB S2flA| £E2t0[E29] 0| & tstt 20| =& U7t
LHE St AL Z2|E USB S2Al E2t0|E22 YL ot LEZ JTof| BA|Z USB S2HA| E210| 22| 3 AL

7tsshOIALE) BI22|e 27|E &g ot
[UTILITY] = [Contents] > [Load]/[Store/Save]

® Yamaha7t S uss Z2A| £20|20] A5G BT}
M3 B2 61HOIZ S HESHIAIL.
stHol= 27 A2 H(0F3) £ &M A(FY H3)0| AL
m OlE Y MR QB O LCDOM EF LHFLICH D2iLt 250l OL2 Y EX7t glLich

MODX+ A8 42X



AP

Fakly MODX8+: 887, GHS AHHZ 7| E{x])
MODX7+: 7621, M| D] 9J|0|E|S AHBHZ 7| E{2])
MODX6+: 6124, M|O| Y0|E|E HBHZ7| E{Z])

EX {208 & A L0l oM HES By AR

=5 AWM2: 8742 2 A

FM-X: 87112 2 TH2{|O|E{, 88712 ¥112|&

ShgS+ AWM2: 12871(Z|CH, AHH /2 0H)
FM-X: 1287H(2| H)

ChssM &Y 1671 DHE(LH3), 2012 43 IHEAD, USB™)
1 AHYL OIE

o Z2|HE:5.67Gb(16H|E 2|L|0f A2 #3} A|), AHE2}: 1.75Gb

HIEHA 2,227

EL 187}2| Al

O|HE A|A” 2| E (1270 YA, HR(8871 FA), AME(A, B) (8874 FAI)2 OrAE 0| E(267] EA)

*2 AID THE QI M E(837 HA)
<2t O|HE Bt o| m2tolE{of LS Z2|ME= HEH22 A3>
OFAE{ EQ(SCHS), 12} THE EQ(3CHY), 22F THE EQ(2C) <)

ANEMEE S8 F 130,00078 S(MWH E&= &)
A 37| ©F 520,00070 S(THE) L Of 520,00070 (&)
2B s 480 pp(4==HEG IHE )
&l I (BPM) 5-300
IHE = I B 12870 THE
Eay 1671 A|HA E2Y
=2 g4 AAIZHEHRLT|, AAIZEE R
& e I B 12874
Ezaf 1670 A2 A E2H Bl E2H Scene E2H
=2 g4 AAIZHBERT|, AAIZEE A, HAIZE HE| Q1/otR
ANHA Al MODX 22| 2|'d Al SMF &4l 0, 1
Ot2H 2| 2 otE SAl 870 THE(2|CH)
D HE 10,2397} 2| Al
User 25671 2] & Al
A AEN 2 8 + 17} 2f Ql(zIch)
7|Et 2to|E ME I 2| M E: 2567H O A, AFR2}: 2,0487Y
HEEZ Z 2% AD Y3 A9l =2 USB S, T|2| HIE &, 25204 &,
HEE £2t0|C(47l), =B (4h), T =8, H|0|& Cto| Y
St 7" TFT Z2{ 2t0|E VGA LCD E{x| A3 2l
g [USB TO DEVICE], [USB TO HOST], MIDI [INJ/[OUT], FOOT CONTROLLER [1]/[2],

FOOT SWITCH [ASSIGNABLE]/[SUSTAIN], OUTPUT [L/MONOJ/[R] (6.3 mm, E= X ),
[PHONES](6.3 mm, & AH|2| 2 E 24)
A/D INPUT [L/MONOJ/[R](6.3 mm, EZ & 2#)

USB @C|Q  A4Z2 =ms4  44.1kHz

QIE{H| 0| A
A L4222 A2 YY)
22410 (5 A8 2 A1)
AC O HE PA-150B &£ 0|0f| £5H= Yamaha B3 A &(£3: DC 12V, 1.5 A)
A A 16 W(PA-150B AC Of H4E{ AL Al)
HESET: MODX8+: 1,333 (W) x 404 (D) x 160 (H) mm, 13.8 kg
MODX7+: 1,144 (W) x 331 (D) x 134 (H) mm, 7.4 kg

MODX6+: 937 (W) x 331 (D) x 134 (H) mm, 6.6 kg




At

7|Et 245 AC O{HE{(PA-150B = 0|0f| 3= OfDfst #& AHE*), AHE LY M (2 22}), Cubase Al L2 2 &
z—lE
* 2|0f wet LEHE| 2| S & QS LICH Yamaha Q0| 22|5HA A 2.

T2 YA LIS S S 2 AYS J|ZOR 51D ASLICH 2A HYMES J1H 22 Yamaha A0S0 Y% F Y MYH HYS Cj2EC
A, AE 1 B o BEE HOHEC (o BE A0 T12f 82E & AL, sHe 21%5) Vamans 7515101 LIS A% HEFLICE

GNU GENERAL PUBLIC LICENSE
GNU LESSER GENERAL PUBLIC LICENSE

AA IE HjREO| 25 Fo|ALet

2|Z 210 F3ENA = GNU 2t 38 2t0|4lA = GNU A Bt S8 20| A0 2t 2to|dlATF 20{E A F2| ZE F20i s 244 ZEE
ML= YamahaOl| Ot A2 O%@ = AS YL

DMI Strategy Planning Group, DMI Division

Digital Musical Instruments D|V|S|on

YAMAHA Corporation

10-1 Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, JAPAN

AABCE 222 YBYUC T AL DES ABAOIA AL B8O ChaA < Yamahao] 8|8 B32 278 4 USUICH
* Yamaha(E £ Yamanao| 5\7H8 e TARZ) 2l0] ABATE £ A ES AT E0IS WA(ZIHAR)SO SMBHE 230l CHEAE LA MY A7
oraLct,
==

e Yamaha’} HE2 =0Ql0) 3715t &2 IES HAEY R ESS LE F 82
LA BEL OIS FA0M CR2EWS 4 ALt
https://download.yamaha.com/sourcecodes/synth/
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A P
AD INPUT [GAINT 5B e 10 [PART SELECT MUTE/SOLO] HHE ..., 15
A/D INPUT [L/MONOY[RT 4 ..o 17 [PERFORMANCE (HOME)] HE ..o, 14
A/D INPUT [ON/OFF] BIE ..o 10 [PHONES] (SIS E) 2H .o, 17
ABS(Audio Beat SYNC) .....oooviiiiiiiiiiii 17
[ARP ON/OFF](OF2H| 2| 2 on/off) HE ..o, 11 R
[ASSIGN 1] 2 [ASSIGN 2] B{E(R| & 7t5 A9z 12 2) ..., 11 [RHYTHM PATTERN] BHE ..., 13
[ASSIGNT HHE ..o, 12
[AUDITIONT BIE ..o 15 S
SCENE [1/5] [2/6] [3/7T] [4/8] HHE ..., 12
C SCENE 7 S oo 34
[CATEGORYIHE ... Scene MEH [1-4] [5-8] HHE .. .12
[CONTROL ASSIGN] H{ & SEQ TRANSPORT HHE ..o 13
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D SSS(Seamless SouNd SWItCHING) .....v.v.veeeeeeeeeeeeeeeeeeeseeene. 23
DAW(C| 2| & 0|2 LIAAEO[M) oo 55 [STORE] H{E 14
[DC INT oot 17
[DEC/NO] BIE oo 14 u
[USB TO DEVICE] TER} oo
E [USB TO HOST] EFRF oo
[EDIT] B e 14 [USB VOLUME (MONITOR)] L& ..
[ENTER] BHE oo 14 IUTILITYT BIE e,
[EXITI BIE oo 14
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FIV e, 38
FOOT CONTROLLER [11/[2] B ..o, 17

FOOT SWITCH [ASSIGNABLE]/[SUSTAIN] 2 ...

G
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B 1mA(5-8) oo 12
I =¥ J|5 [TONE)/[EG/FX)/[EQ)/[ARPMS] HE ... 12
INC/YESI BHE oo 14
c
K CHZ OtE HEoA
KNOB POSITION [1] 2 [2] HE ..o 13 QU IFE THELTHA e 22
[OUCHZIHZ) AZR| oo 17
L EOTE] CFOI oot 14
[LIVE SET] IS oo, 15 CR IME 22
M a
MASTER VOLUME ..., 10 BEOIE MIE oo, 23,35
[MASTER VOLUME] s 5 e, 10 [2l0|E M E] &}H
MIDI[INT, [OUT] SERE oo, 17 BHOIE 2] B e,
MIDI S e, 45 B 01 O oo, 41
MIDIELE e, 56 B HER 53
[MOTION SEQ HOLDJ(2M AZEM EE)HE e, 11 RIS ThE 43
[MOTION SEQ TRIGGER](2M Al A E2|H)HE ... 11 RIS TN e 43
[MS ON/OFF)(24 Al M onfoff) HE ... 11
o
OCTAVE [[] L [+] BIE oo, 11
OUTPUT [L/MONOT L [R] 2H ..o, 17
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| NORTH AMERICA |

CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Toronto, Ontario M1S 3R1,
Canada
Tel: +1-416-298-1311
U.S.A.
Yamaha Corporation of America
6600 Orangethorpe Avenue, Buena Park, CA 90620,
U.S.A

Tel: +1-714-522-9011

[ CENTRAL & SOUTH AMERICA |

MEXICO
Yamaha de México, S.A. de C.V.
Av. Insurgentes Sur 1647 Piso 9, Col. San José
Insurgentes, Delegacion Benito Juarez, CDMX,
C.P. 03900, México
Tel: +52-55-5804-0600
BRAZIL
Yamaha Musical do Brasil Ltda.
Praga Professor José Lannes, 40-Cjs 21 e 22, Brooklin
Paulista Novo CEP 04571-100 — Sao Paulo — SP,
Brazil
Tel: +55-11-3704-1377
ARGENTINA
Yamaha Music Latin America, S.A.,
Sucursal Argentina
Olga Cossettini 1553, Piso 4 Norte,
Madero Este-C1107CEK,
Buenos Aires, Argentina
Tel: +54-11-4119-7000
PANAMA AND OTHER LATIN
AMERICAN REGIONS/
CARIBBEAN REGIONS
Yamaha Music Latin America, S.A.
Edificio Torre Davivienda, Piso: 20
Avenida Balboa, Marbella, Corregimiento de Bella
Vista, Ciudad de Panamad, Rep. de Panama
Tel: +507-269-5311

I EUROPE |

THE UNITED KINGDOM/IRELAND
Yamaha Music Europe GmbH (UK)
Sherbourne Drive, Tilbrook, Milton Keynes,
MK7 8BL, U.K.

Tel: +44-1908-366700

GERMANY
Yamaha Music Europe GmbH
Siemensstrasse 22-34, 25462 Rellingen, Germany
Tel: +49-4101-303-0

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Europe GmbH, Branch
Switzerland in Thalwil
Seestrasse 18a, 8800 Thalwil, Switzerland
Tel: +41-44-3878080

AUSTRIA/CROATIA/CZECH REPUBLIC/

HUNGARY/ROMANIA/SLOVAKIA/

SLOVENIA
Yamaha Music Europe GmbH, Branch Austria
Schleiergasse 20, 1100 Wien, Austria
Tel: +43-1-60203900

POLAND
Yamaha Music Europe
Sp.z 0.0. Oddzial w Polsce
ul. Wielicka 52, 02-657 Warszawa, Poland
Tel: +48-22-880-08-88

BULGARIA
Dinacord Bulgaria LTD.

Bul.Iskarsko Schose 7 Targowski Zentar Ewropa
1528 Sofia, Bulgaria
Tel: +359-2-978-20-25

MALTA
Olimpus Music Ltd.

Valletta Road, Mosta MST9010, Malta
Tel: +356-2133-2093

NETHERLANDS/BELGIUM/

LUXEMBOURG
Yamaha Music Europe, Branch Benelux
Clarissenhof 5b, 4133 AB Vianen, The Netherlands
Tel: +31-347-358040

FRANCE
Yamaha Music Europe
7 rue Ambroise Croizat, Zone d'activités de Pariest,
77183 Croissy-Beaubourg, France
Tel: +33-1-6461-4000

ITALY
Yamaha Music Europe GmbH, Branch Italy
Via Tinelli N.67/69 20855 Gerno di Lesmo (MB),
Italy
Tel: +39-039-9065-1

SPAIN/PORTUGAL
Yamaha Music Europe GmbH Ibérica, Sucursal
en Espaia
Ctra. de la Corufia km. 17,200, 28231
Las Rozas de Madrid, Spain
Tel: +34-91-639-88-88
GREECE
Philippos Nakas S.A. The Music House
19th klm. Leof. Lavriou 190 02 Peania — Attiki,
Greece
Tel: +30-210-6686260

SWEDEN
Yamaha Music Europe GmbH Germany Filial
Scandinavia
JA Wettergrensgata 1, 400 43 Géteborg, Sweden
Tel: +46-31-89-34-00

DENMARK
Yamaha Music Denmark,
Fillial of Yamaha Music Europe GmbH, Tyskland
Generatorvej 8C, ST. TH., 2860 Seborg, Denmark
Tel: +45-44-92-49-00

FINLAND
F-Musiikki Oy
Antaksentie 4
FI-01510 Vantaa, Finland
Tel: +358 (0)96185111

NORWAY
Yamaha Music Europe GmbH Germany -
Norwegian Branch
Grini Neeringspark 1, 1332 @steras, Norway
Tel: +47-6716-7800

ICELAND
Hljodfaerahusid Ehf.
Sidumula 20
IS-108 Reykjavik, Iceland
Tel: +354-525-5050
CYPRUS
Nakas Music Cyprus Ltd.
Nikis Ave 2k
1086 Nicosia
Tel: +357-22-511080
Major Music Center
21 Ali Riza Ave. Ortakoy
P.0.Box 475 Letkosa, Cyprus
Tel: (392) 227 9213
RUSSIA
Yamaha Music (Russia) LLC.
Room 37, entrance 7, bld. 7, Kievskaya street,
Moscow, 121059, Russia
Tel: +7-495-626-5005
OTHER EUROPEAN REGIONS
Yamaha Music Europe GmbH
Siemensstrasse 22-34, 25462 Rellingen, Germany
Tel: +49-4101-303-0

I AFRICA

Yamaha Music Gulf FZE

JAFZA-16, Office 512, P.O.Box 17328,
Jebel Ali FZE, Dubai, UAE

Tel: +971-4-801-1500

| MIDDLE EAST

TURKEY
Yamaha Music Europe GmbH
Merkezi Almanya Tiirkiye Istanbul Subesi
Mor Sumbul Sokak Varyap Meridian Business
1.Blok No:1 113-114-115
Bati Atasehir Istanbul, Turkey
Tel: +90-216-275-7960
ISRAEL
RBX International Co., Ltd.
P.O Box 10245, Petach-Tikva, 49002
Tel: (972) 3-925-6900

OTHER REGIONS
Yamaha Music Gulf FZE
JAFZA-16, Office 512, P.O.Box 17328,
Jebel Ali FZE, Dubai, UAE
Tel: +971-4-801-1500

| ASIA |

THE PEOPLE’S REPUBLIC OF CHINA
Yamaha Music & Electronics (China) Co., Ltd.
2F, Yunhedasha, 1818 Xinzha-lu, Jingan-qu,
Shanghai, China
Tel: +86-400-051-7700

HONG KONG
Tom Lee Music Co., Ltd.
11/F., Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: +852-2737-7688

INDIA
Yamaha Music India Private Limited
P-401, JMD Megapolis, Sector-48, Sohna Road,
Gurugram-122018, Haryana, India
Tel: +91-124-485-3300

INDONESIA
PT Yamaha Musik Indonesia Distributor
Yamaha Music Center Bldg. Jalan Jend. Gatot
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: +62-21-520-2577

KOREA
Yamaha Music Korea Ltd.
11F, Prudential Tower, 298, Gangnam-daero,
Gangnam-gu, Seoul, 06253, Korea
Tel: +82-2-3467-3300

MALAYSIA
Yamaha Music (Malaysia) Sdn. Bhd.
No.8, Jalan Perbandaran, Kelana Jaya, 47301
Petaling Jaya, Selangor, Malaysia
Tel: +60-3-78030900

SINGAPORE
Yamaha Music (Asia) Private Limited
Block 202 Hougang Street 21, #02-00,
Singapore 530202, Singapore
Tel: +65-6740-9200

TAIWAN
Yamaha Music & Electronics Taiwan Co., Ltd.
2F., No.1, Yuandong Rd., Bangiao Dist.,
New Taipei City 22063, Taiwan (R.0.C.)
Tel: +886-2-7741-8888

THAILAND
Siam Music Yamaha Co., Ltd.
3,4, 15, 16th F1., Siam Motors Building,
891/1 Rama | Road, Wangmai,
Pathumwan, Bangkok 10330, Thailand
Tel: +66-2215-2622

VIETNAM
Yamaha Music Vietnam Company Limited
15th Floor, Nam A Bank Tower, 201-203 Cach
Mang Thang Tam St., Ward 4, Dist.3,
Ho Chi Minh City, Vietnam
Tel: +84-28-3818-1122

OTHER ASIAN REGIONS

https://asia-latinamerica-mea.yamaha.com/
index.html

I OCEANIA

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 80 Market Street, South Melbourne,
VIC 3205 Australia
Tel: +61-3-9693-5111
NEW ZEALAND
Music Works LTD
P.0.BOX 6246 Wellesley, Auckland 4680,
New Zealand
Tel: +64-9-634-0099
REGIONS AND TRUST
TERRITORIES IN PACIFIC OCEAN
https://asia-latinamerica-mea.yamaha.com/
index.html

Head Office/Manufacturer: Yamaha Corporation 10-1, Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, Japan

DMI30

Importer (European Union): Yamaha Music Europe GmbH Siemensstrasse 22-34, 25462 Rellingen, Germany
Importer (United Kingdom): Yamaha Music Europe GmbH (UK) Sherbourne Drive, Tilbrook, Milton Keynes, MK7 8BL, United Kingdom
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